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INTRODUCTION 
The purpose of this report is to provide results from the Lake Loading Response Model (LLRM) developed for Gregg Lake. The 
LLRM is an Excel-based model that uses environmental data to develop a water and phosphorus loading budget for lakes and 
their tributaries1. Water and phosphorus loads (in the form of mass and concentration) are traced from various sources in the 
watershed through tributary basins and into the lake. The model incorporates data about watershed and sub-basin 
boundaries, land cover, point sources (if applicable), septic systems, waterfowl, rainfall, volume and surface area, and 
internal phosphorus loading.  These data are combined with coefficients, attenuation factors, and equations from scientific 
literature on lakes, rivers, and nutrient cycles. The following describes the process by which critical model inputs were 
determined using available resources and GIS modeling, and presents annual average predictions2 of total phosphorus, 
chlorophyll-a, Secchi disk transparency, and algal bloom probability. The model can be used to identify current and future 
pollution sources, estimate pollution limits and water quality goals, and guide watershed improvement projects. 

WATERSHED AND SUB-BASIN DELINEATIONS 
Watershed and tributary drainage basin (sub-
basin) boundaries are needed to determine both 
the amount of water flowing into the lake and the 
area of different land cover types contributing to 
nutrient loading. FBE completed preliminary 
modeling of sub-basins for the watershed using 
ESRI Spatial Analyst, QGIS, and EPA BASINS. 
QGIS and EPA BASINS are both open source 
spatial mapping and analysis programs. FBE 
used 2-foot contour data developed from USGS 
7.5-minute digital line graphs (hypsography), as 
well as the location of phosphorus sampling 
sites, to manually confirm the modeled sub-
basin boundary delineations, all of which were 
snapped to the original watershed boundary 
obtained from NH GRANIT. FBE performed 
ground-truthing in the watershed to identify flow 
directions, esp. in areas where gentle hills and 
road shoulder ditches redirected flows. The final 
sub-basin delineations are shown in Figure 1.  

LAND COVER UPDATE 
Land cover determines the movement of water 
and phosphorus from the watershed to surface 
waterbodies via surface runoff and baseflow 
(groundwater). A significant amount of time 
went into reviewing and refining the land cover 
data. The 2001 New Hampshire Landcover 
Database (NHLCD) accessed from NH GRANIT 
was used as a baseline for editing. First, the 
NHLCD categories were translated into similar 
LLRM land cover categories (refer to Attachment 
1). Next, rectangular grids (or quads) were 

                                                      
 
1 AECOM (2009). LLRM Lake Loading Response Model Users Guide and Quality Assurance Project Plan. AECOM, Willington, CT. 
2 The model cannot simulate short-term weather or loading events. 

FIGURE 1. Comparison among modeled and final ground-truthed sub-
basin boundaries for the Gregg Lake watershed. Sub-basins were selected 
based on available phosphorus data.  
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created to break up the watershed into more manageable portions for review.  

ESRI World imagery dated 6/12/2017 and Google Earth satellite images as recent as 9/11/2017 were reviewed for major land 
cover changes in each quad since the 2001 assessment. If discrepancies between the aerials and the NHLCD file were found, 
changes were made using the Topology tool for editing polygon vertices or the Editor tool for splitting polygons. Each new 
polygon was relabeled in the attribute table with the appropriate LLRM land cover category. FBE confirmed land cover areas 
in the field where desktop aerial review was inconclusive.  

A few assumptions or actions were made during this process: 

• Forest 3: Mixed was used as the default category for land assigned to forest.  
• Agricultural fields that were clearly not pasture or row crops were defaulted to “Agric 4: Hayfield”; it was difficult to 

discern whether a field was hayfield or cover crop and so no cover crops were delineated in the watershed. FBE 
refined land cover by distinguishing among hayfields, meadows that were scrub-shrub, non-wetland areas (“Open 
2: Meadow”), or extensive lawns/athletic fields such as those associated with camps (“Urban 5: Open Space”); 
residential lawns were included in Urban 1. 

• Recent or historically logged areas were not differentiated from forested land cover types. 
• Major bare soil areas (including beaches) that were not associated with new residential home construction were 

labeled as “Open 3: Excavation.” 
• Palustrine wetland areas from the National Wetlands Inventory (NWI) were added as “Forest 4: Wetlands.” 
• Unpaved roads from the NHDOT roads layer (NH GRANIT) were added as “Other 1: Unpaved Roads” and confirmed 

in the field, wherever accessible. 

Agricultural and developed lands were checked carefully since modeling coefficients (i.e., phosphorus export) are generally 
higher for those land cover types. Aerials were checked thoroughly for each major agricultural or developed area to 
distinguish between hayfields, grazing/pasture, lawns, and meadows. Refer to Attachment 2 for examples of how some land 
cover categories were distinguished in the watershed. The resulting updated land cover file is a more accurate representation 
of current land cover within the Gregg Lake watershed (refer to Figure 2 for zoomed-in examples of “before” and “after” 
modifications). The final land cover is shown in Attachment 3. 

Within the LLRM, export coefficients are assigned to each land cover to represent typical concentrations of phosphorus in 
runoff and baseflow from those land cover types (Attachment 4). Unmanaged forested land, for example, tends to deliver very 
little phosphorus downstream when it rains, while low to high density urban development export significantly more 
phosphorus due to lack of infiltration, fertilizer use, soil erosion, car and factory exhaust, pet waste, and many other sources. 
Smaller amounts of phosphorus are also exported to lakes and streams via groundwater under baseflow conditions. This 
nutrient load is delivered with groundwater to the lake directly or to tributary streams; however, much of the phosphorus is 
adsorbed onto soil particles as water infiltrates to the ground. Attachment 4 presents the runoff and baseflow phosphorus 
export coefficients for each land cover type used in the model, along with the total land cover area by land cover type and 
sub-basin. These coefficients were based on values from Tarpey 2013, 2001 East Pond TMDL Report, Reckhow et al. 1980, 
Hutchinson Environmental Sciences Ltd 2014, and Schloss and Connor 2000, among others.  

Figure 3 shows a basic breakdown of land cover by major category for the entire watershed (not including lake area), as well 
as total phosphorus load by major land cover category. Developed areas cover 4% of the watershed and contribute 51% of 
the total phosphorus watershed load to Gregg Lake. 
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FIGURE 2. Example of “before” (left) and “after” (right) land cover file modifications for the Gregg Lake watershed.  

 

 

 
FIGURE 3. Watershed land cover area by general category (developed, agriculture, forest, and water/wetlands) and total 
phosphorus (TP) watershed load by general land cover type. This shows that developed areas cover 4% of the watershed 
and contribute 51% of the TP watershed load to Gregg Lake. 
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OTHER MAJOR LLRM INPUTS 
The following presents a brief outline of other variable sources and assumptions input to the model. Refer to Limitations to 
the Model for further discussion. 

• Monthly precipitation data were obtained from NOAA NCEI for the EDWARD MACDOWELL LAKE, NH (USC00275013) 
weather station with data gaps covered by weather stations in MARLOW, NH (USC00275150), PETERBORO 2 S, NH 
(USC00276697), and Jaffrey Municipal Airport Silver Ranch, NH (USW00054770). Average annual precipitation totals 
from 2009-2018 were input to the model (50.683 in or 1.287 m).  

• Lake volume and area estimates were obtained from the New Hampshire Fish & Game Department (NHFGD) and 
New Hampshire Department of Environmental Services (NHDES) bathymetry shapefile (via NH GRANIT). The lake 
volume estimates from the NHFGD and NHDES were 3% and 4% greater than the VLAP volume estimate, respectively. 
The lake surface area estimates from the NHFGD and NHDES were both 1% greater than the VLAP area estimate. 
NHFGD bathymetry data were used for the model.  

• Septic system data were obtained from a database of 55 lakeshore properties surveyed in July-December 2019 by 
the Town of Antrim. Any missing survey information was obtained from property cards. The survey results included 
information on the age and usage (seasonal or year-round and occupancy) of septic systems within 250 feet of the 
lake, which was used to calculate a water and phosphorus load to the lake from septic systems. 

• Water quality data were obtained from NHDES Environmental Monitoring Database (EMD). The model was 
calibrated using tributary and lake samples taken between 2009 and 2018 (recent 10 years). Sites were only included 
if they were a close match to the outlet of a sub-basin used in the model. Data were summarized by day, then month, 
then all data to obtain median water quality summaries for total phosphorus, chlorophyll-a, and Secchi Disk 
Transparency. Data analysis can be found in the Gregg Lake Water Quality Summary Report prepared by the Gregg 
Lake Watershed Management Plan Committee (February 2019).  

• Waterfowl data were acquired from eBird online. Species classified as “waterfowl” include the Canada goose, 
mallard, bald eagle, wood duck, common loon, and great blue heron. Fifteen individuals of these species were 
spotted from August-September 2018. However, a standard estimate of 0.3 birds per hectare of lake surface area (or 
24 individuals) was used instead because the bird census data were deemed insufficient and likely underestimating 
the bird count. Waterfowl can be a direct source of nutrients to lakes; however, if they are eating from the lake and 
their waste returns to the lake, the net change may be less than might otherwise be assumed; even so, the 
phosphorus excreted may be in a form that can be readily used by algae and plants. 

• Internal loading estimates were derived from dissolved oxygen and temperature profiles taken at the deep spot of 
Gregg Lake from 2009-2018 (to determine average annual duration and depth of anoxia defined as <1 ppm dissolved 
oxygen) and epilimnion/hypolimnion total phosphorus data taken at the deep spot of Gregg Lake from 2009-2018 
(to determine average difference between surface and bottom phosphorus concentrations). These estimates, along 
with anoxic volume and surface area, helped determine rate of release and mass of annual internal phosphorus load.  

CALIBRATION 
Calibration is the process by which model results are brought into agreement with observed data and is an essential part of 
environmental modeling. Usually, calibration focuses on the input data with the greatest uncertainty. Changes are made 
within a plausible range of values, and an effort is made to find a realistic explanation among environmental conditions for 
these changes. In-stream phosphorus concentrations were used as guideposts, but attenuation values were generally 
defaulted to reflect little attenuation because of the watershed’s steep slopes (Table 1). Observed in-lake phosphorus 
concentrations were given primacy during the calibration process, such that the ability of the model to accurately simulate 
annual average in-lake phosphorus concentrations was used as a leading indicator of acceptable model performance. 
Continued water quality sampling in the watershed can be designed to reduce the uncertainty encountered in modeling and 
help assess changes made during calibration. 

The following key calibration input parameter values and modeling assumptions were made: 

• The standard water yield coefficient was input as 2.0 cubic ft/sq. m, which is the high end of the range for New 
England but reflects the watershed’s steep slopes and high runoff potential.  

• Direct atmospheric deposition phosphorus export coefficient was assumed to be 0.11 kg/ha/yr from Schloss et al. 
(2013) and represents a largely undeveloped watershed. 
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• Default water and phosphorus attenuation factors were used with a couple exceptions as noted in Table 1. Water 
can be lost through evapotranspiration, deep groundwater, and wetlands, while phosphorus can be removed by 
infiltration or uptake processes. We generally expected at least a 5% loss (95% passed through, default) in water and 
a 10% loss (90% passed through, default) in phosphorus for each sub-basin. Larger water losses (<95% passed 
through) were expected with lower gradient or wetland-dominated sub-basins. Additional infiltration, filtration, 
detention, and uptake of phosphorus will lower the phosphorus attenuation value, such as for sub-basins dominated 
by moderate/small ponds or wetlands (75%-85% passed through) or channel processes that favor uptake (85% 
passed through), depending on the gradient. Headwater systems were assumed to have a greater attenuation than 
higher order streams since the flow of water is lower, giving more opportunity for infiltration, adsorption, and uptake. 

• The average of multiple empirical formulas for predicting annual in-lake phosphorus concentration included 
Vollenweider (1975) and Jones-Bachmann (1976) because results from those models best matched conditions 
observed in the lake over the past 10 years.  
 

TABLE 1. Reasoning for water and phosphorus attenuation factors used by sub-basin.  

Sub-Basin 

Water 
Atten. 
Factor 

Phos. 
Atten. 
Factor Reasoning (water; phosphorus (P)) 

Castor Lane 0.95 0.85 Default water attenuation factor (due to steep slopes); slight increase in P attenuation due to 
moderate sized pond-wetland complex. 

Direct Shoreline 0.95 0.90 Default water and P attenuation factor (due to steep slopes). 

Hattie Brown Road 0.98 0.95 
Less attenuation for higher order streams to account for cumulative retention (Hattie Brown 
Road North and West Tribs feed into this sub-basin). 

Hattie Brown Road North Trib 0.95 0.90 Default water and P attenuation factor (due to steep slopes). 
Hattie Brown Road West Trib 0.95 0.90 Default water and P attenuation factor (due to steep slopes). 
Willard Mountain 0.95 0.90 Default water and P attenuation factor (due to steep slopes). 

 

LIMITATIONS TO THE MODEL 
There were several limitations to the model; literature values and best professional judgement were used in place of 
measured data, wherever appropriate. Acknowledging and understanding model limitations is critical to interpreting model 
results and applying any derived conclusions to management decisions. The model should be viewed as one of many tools 
available for lake management. Because the LLRM incorporates specific waterbody information and is flexible in applying 
new data inputs, it is a powerful tool that predicts annual average in-lake total phosphorus concentrations with a high degree 
of confidence; however, model confidence can be increased with more data. The following lists specific limitations to the 
model: 

• The model represents a static snapshot in time based on the best information available at the time of model 
execution. Factors that influence water quality are dynamic and constantly evolving; thus, the model should be 
regularly updated when significant changes occur within the watershed and as new water quality and physical data 
are collected. In this respect, the model should only be considered up-to-date on the date of its release. Model results 
represent annual averages and are best used for planning level purposes and should only be used with full 
recognition of the model limitations and assumptions. 

• Limited data were available for sub-basins. Most sub-basins had a weak dataset (n ≈ 3) available for model 
calibration; the dataset could be made stronger with continued data collection at existing active sites, as well as at 
three sites with limited data (n = 1-4): Castor Lane, Craig Rd Bridge, Hattie Brown Brook, and Hattie Brown Rd. 
Collecting samples under a variety of flow conditions (and measuring flow) across several years can help reduce this 
uncertainty. More data are needed to effectively calibrate the model to known observations for these sub-basins. 
Until more data are available, we assumed that similar land cover coefficients and attenuation values used in other 
sub-basins with more certainty would be applicable to the sub-basins with less certainty due to limited data.  

• Internal loading estimates were based on data concentrated in recent years. Phosphorus that enters the lake 
and settles to the bottom can be re-released from sediment under anoxic conditions, providing a nutrient source for 
algae and other plants. Internal phosphorus loading can also result from wind-driven wave action or physical 
disturbance of the sediment (boat props, aquatic macrophyte management activities). Dissolved oxygen and 
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temperature profiles were collected once a year from 1997 - 2001 and from 2005 - 2014. Sampling frequency 
increased in 2016 (once per month from June - August) and in 2017 and 2018 (once per month from April - October). 
Continuing a high sampling frequency would improve any future updates to the model.  

• Septic system loading was estimated based on default literature values. Default literature values for daily water 
usage, phosphorus concentration output per person, and system phosphorus attenuation factors were used and 
may not reflect local watershed conditions. 

• Waterfowl counts were based on default estimates. In the future, a large bird census throughout the year, not 
strictly August and September, would help improve the model loading estimates.   

• Land cover export coefficients were estimates. Literature values and best professional judgement were used in 
evaluating and selecting appropriate land cover export coefficients for Gregg Lake. While these coefficients may be 
accurate on a larger scale, they are likely not representative on a site-by-site basis. Refer to documentation within 
the LLRM spreadsheet for specific citations.  

RESULTS 
CURRENT LOAD ESTIMATION 

Overall, model predictions were in good agreement with observed data and were within <1% to 3% relative percent difference 
of observed mean annual total phosphorus, chlorophyll-a, and Secchi disk transparency (Table 2). It is important to note that 
the LLRM does not explicitly account for all the biogeochemical processes occurring within a waterbody that contribute to 
overall water quality and is less accurate at predicting chlorophyll-a and Secchi disk transparency. For example, chlorophyll-
a is estimated strictly from nutrient loading, but other factors strongly affect algae growth, including low light from suspended 
sediment, grazing by zooplankton, presence of heterotrophic algae, and flushing effects from high flows. There were 
insufficient data available to evaluate the influence of these other factors on observed chlorophyll-a concentrations and 
Secchi disk transparency readings.  

Watershed runoff combined with baseflow (72%) was the largest phosphorus loading contribution across all sources to Gregg 
Lake, followed by atmospheric deposition (9%), internal loading (9%), septic systems (6%), and waterfowl (4%) (Table 3; 
Figure 4). Development in the watershed is most concentrated around the shoreline where septic systems or holding tanks 
are located within a short distance to the water, leaving little horizontal (and sometimes vertical) space for proper filtration 
of wastewater effluent. Improper maintenance or siting of these systems can cause failures, which leach untreated, nutrient-
rich wastewater effluent to the lake.  

Internal loading is also a concern for Gregg Lake given that low dissolved oxygen in bottom waters is causing a significant 
release of phosphorus from bottom sediments (as evidenced by the moderate difference between bottom and surface 
phosphorus concentrations (7.8 ppb)). Low flushing rate in late summer may further exacerbate internal loading as both the 
duration of anoxia and the residence time for nutrients are prolonged.  

The direct shoreline area to Gregg Lake had the highest phosphorus export by total mass, followed distantly by Willard 
Mountain (Table 4). Drainage areas directly adjacent to waterbodies have direct connection with the lake and are usually 
targeted for development, thus increasing the possibility for phosphorus export. Normalizing for the size of a tributary (i.e., 
accounting for its annual discharge and direct drainage area) better highlights sub-basins with elevated pollutant exports 
relative to their drainage area. Sub-basins with moderate-to-high phosphorus mass exported by area (> 0.1 kg/ha/yr) 
generally had more development (i.e., the direct shoreline; Table 4). Limited observed phosphorus data were available for 
the outlets of the sub-basins but observed data showed higher-than-predicted concentrations likely due to low flow, seasonal 
conditions under which the samples were collected. More data are needed to better confirm the coefficients and attenuation 
factors used for those sub-basins. 

 PRE-DEVELOPMENT LOAD ESTIMATION 

Once the model is calibrated for current in-lake phosphorus concentration, we can then manipulate land cover and other 
factor loadings to estimate pre-development loading scenarios (e.g., what in-lake phosphorus concentration was prior to 
human development or the best possible water quality for the lake). Refer to Attachment 5 for details on methodology. 

Pre-development loading estimation showed that total phosphorus loading increased by 118%, from 45 kg/yr prior to 
European settlement to 98 kg/yr under current conditions, for Gregg Lake (Table 3; Figure 4). These additional phosphorus 
sources are coming from development in the watershed (especially in the direct shoreline of Gregg Lake), septic systems, 



GREGG LAKE WATERSHED | LAKE LOADING RESPONSE MODEL 

FB Environmental Associates  7 

atmospheric dust, and internal loading (Tables 3, 5; Figure 4). Water quality prior to settlement was likely excellent with 
extremely low phosphorus and chlorophyll-a concentrations and high water clarity (Table 2).  

FUTURE LOAD ESTIMATION 

We can also manipulate land cover and other factor loadings to estimate future loading scenarios (e.g., what in-lake 
phosphorus concentration might be at full build-out under current zoning constraints or the worst possible water quality for 
the lake). Refer to Attachment 6 and the Build-out Analysis Report for details on methodology. Note: the future scenario did 
not assume a 10% increase in precipitation over the next century (NOAA Technical Report NESDIS 142-1, 2013), which would 
have resulted in a lower predicted in-lake phosphorus concentration; this is because the model does not consider the rate 
and distribution of the projected increase in precipitation. Climate change models predict more intense and less frequent 
rain events that may exacerbate erosion of phosphorus-laden sediment to surface waters and therefore could increase in-
lake phosphorus concentration (despite dilution and flushing impacts that the model assumes).  

Future loading estimation showed that total phosphorus loading may increase by 115%, from 98 kg/yr under current 
conditions to 211 kg/yr at full build-out (2180) under current zoning, for Gregg Lake (Table 3; Figure 4). Additional phosphorus 
will be generated from more development in the watershed (especially from the direct shoreline of Gregg Lake, followed by 
Willard Mountain and Hattie Brown Road sub-basins), greater atmospheric dust, more septic systems, and enhanced internal 
loading (Table 3, 5; Figure 4). The model predicted significantly higher (worse) phosphorus (17.6 ppb), higher (worse) 
chlorophyll-a (8.8 ppb), and lower (worse) water clarity (2.6 m) compared to current conditions (Table 2). Any new increases 
in phosphorus to a lake can disrupt the ecological balance in favor of increased algal growth, resulting in degraded water 
clarity. The impact from new buildings and septic systems can be greatly reduced by implementing low impact development 
(LID) techniques and ensuring that all new septic systems are well separated from surface waters both horizontally and 
vertically (above seasonal high groundwater in suitable soil). 

 

TABLE 2. In-lake water quality predictions for Gregg Lake. TP = total phosphorus. Chl-a = chlorophyll-a. SDT = Secchi disk 
transparency. 

Model Scenario 
Median TP 

(ppb) 
Predicted Median TP 

(ppb) 
Mean Chl-a 

(ppb) 
Predicted Mean Chl-a 

(ppb) 
Mean SDT 

(m) 
Predicted Mean SDT 

(m) 
Pre-Development  -- 3.4  -- 2.0  -- 8.3 

Current (2018) 6.8 (8.2) 8.2 4.3 4.2 4.7 4.6 
Future (2180)  -- 17.6  -- 8.8  -- 2.6 

*Median TP concentration of 6.8 ppb represents existing in-lake epilimnion TP from observed data. Median TP concentration of 8.2 ppb represents 20% 
greater than actual median values as the value used to calibrate the model.  Most lake data are collected in summer when TP concentrations are 
typically lower than annual average concentrations for which the model predicts 

 

TABLE 3. Total phosphorus (TP) and water loading summary by source. 

SOURCE 
PRE-DEVELOPMENT CURRENT (2018) FUTURE (2180) 

TP  
(KG/YR) 

% 
WATER 

(CU.M/YR) 
TP  

(KG/YR) 
% 

WATER 
(CU.M/YR) 

TP  
(KG/YR) 

% 
WATER 

(CU.M/YR) 
ATMOSPHERIC  6 13% 629,700 9 9% 629,700 20 10% 629,700 
INTERNAL  0 0% 0 9 9% 0 28 13% 0 
WATERFOWL  3 7% 0 3 4% 0 3 2% 0 
SEPTIC SYSTEM  0 0% 0 6 6% 4,874 13 6% 10,428 
WATERSHED LOAD  36 80% 7,538,936 71 72% 7,542,824 146 69% 7,551,326 
TOTAL LOAD TO LAKE 45 100% 8,168,636 98 100% 8,177,398 211 100% 8,191,454 

 



GREGG LAKE WATERSHED | LAKE LOADING RESPONSE MODEL 

FB Environmental Associates  8 

 
FIGURE 4. Total phosphorus (TP) loading (kg/yr) by source (atmospheric, internal loading, waterfowl, septic systems, 
watershed load) for pre-development, current, and future modeling scenarios. 

 

TABLE 4. Summary of land area, water flow, and total phosphorus (TP) loading by sub-basin (non-cumulative if a sub-basin 
contributes to another sub-basin, except for water flow). 

Sub-Basin 
Watershed Loads 

Land 
Area (ha) 

Water Flow 
(m3/year) 

Calculated P 
Concentration (mg/L) 

Measured P 
Concentration (mg/L) 

P mass 
(kg/year) 

P mass by area 
(kg/ha/year) 

Castor Lane 205.7 0 0.005 0.018 8.0 0.04 
Direct Shoreline 336.6 2,450,887 0.018 no data 43.9 0.13 
Hattie Brown Road 64.5 2,083,323 0.004 0.011 2.6 0.04 
Hattie Brown Road North Trib 109.2 0 0.004 no data 3.3 0.03 
Hattie Brown Road West Trib 118.1 0 0.004 no data 3.7 0.03 
Willard Mountain 226.0 3,008,613 0.006 0.014 10.2 0.05 

 

TABLE 5. Total phosphorus (TP) watershed loading summary (total mass and total mass per area) by sub-basin for pre-
development, current, and future modeling scenarios. 

Sub-Basin 

Watershed Load 
Pre-Development Current (2018) Future (2180) 

TP Load (kg/yr) TP Load (kg/ha/yr) TP Load (kg/yr) TP Load (kg/ha/yr) TP Load (kg/yr) TP Load (kg/ha/yr) 
Castor Lane 6.2 0.03 8.0 0.04 12.2 0.06 
Direct Shoreline 14.2 0.04 43.9 0.13 73.3 0.22 
Hattie Brown Road 2.0 0.03 2.6 0.04 13.4 0.21 
Hattie Brown Road North Trib 3.3 0.03 3.3 0.03 9.1 0.08 
Hattie Brown Road West Trib 3.7 0.03 3.7 0.03 9.2 0.08 
Willard Mountain 7.6 0.03 10.2 0.05 30.6 0.14 
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CONCLUSION 
Based on model analysis of pre-development, current, and future water quality conditions, Gregg Lake is at risk for water 
quality degradation from future development under current zoning. Additional phosphorus loading from the watershed and 
internal sediments will likely accelerate water quality degradation of the lake, though the relationship between total 
phosphorus and chlorophyll-a appears to not be directly causal3 at least at a seasonal scale when most samples were 
collected (Figure 5). However, the model predicted both total phosphorus and chlorophyll-a well at the annual average scale, 
indicating that total phosphorus is still an important driver of chlorophyll-a concentrations in Gregg Lake. Gregg Lake has 
already surpassed the maximum oligotrophic criterion for chlorophyll-a at 3.3 ppb despite the relatively low total phosphorus 
concentration in the lake that shows a remaining assimilative capacity of 0.4 ppb. Given Gregg Lake’s recreational and aquatic 
habitat value in the region, it will be crucial to both maximize land conservation of intact forestland and consider zoning 
ordinance amendments that encourage low impact development techniques on existing and new development.  

 

 
FIGURE 5. The relationship between chlorophyll-a and total phosphorus in Gregg Lake deep spot (GREANTD) shows that 
chlorophyll-a (measure of algae) in unresponsive to changes in total phosphorus concentration in the epilimnion, 
metalimnion, and hypolimnion, at least as a seasonal scale when most samples were collected. Thresholds (red lines) for 
chlorophyll-a and total phosphorus for oligotrophic (3.3 ppb Chl-a, 8 ppb TP) and mesotrophic (5 ppb Chl-a, 12 ppb TP) 
waterbodies per NHDES are shown for epilimnion chlorophyll-a and total phosphorus figure only. 

 

  

                                                      
 
3 We recommend including total nitrogen analyses as part of the regular monitoring program. 
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ATTACHMENT 1: Land cover File Update Workflow Record 

LLRM Land Cover Update Workflow 
5/15/2018 C. Bunyon 
Project #396 Gregg Lake WMP 
 
All data projected in NAD 1983 State Plane NH FIPS 2800 feet 
 
ESRI World Imagery dated 6/12/2017 
Google Earth Imagery dated 9/11/2017 
   
Land cover file from NH GRANIT: nhlc01 
 ArcToolbox >Data Management Tools > Raster > Raster Processing > Clip 
  Extent clipped to “gregg_wshed” 
  File = “nhlc01_gregg” 

ArcToolbox >Conversion Tools > From Raster > Raster to Polygon 
  File = “nhlc01_gregg_before”  
 

Add text field > “LLRM_code” (open attribute table, table options, Add field..) 
Rename land cover classes to match LLRM categories 

Note: the following list displays relevant LLRM codes and NHLC01 Gridcodes that may or may not exist in 
the Gregg Lake watershed 

  LLRM_code / NHLC01 GRIDCODE 
“Urban 1: Low Den Res” / 110 
Urban 2: Commercial/Mid Den Res / NA 
Urban 3: Roads / 140 
Urban 4: Industrial / NA 
Urban 5: Open Space/Mowed / NA 
Agric 1: Cover Crop / NA 
Agric 2: Row Crop / 211, 221 
Agric 3: Grazing / NA 
Agric 4: Hayfield / 212  
Forest 1: Deciduous / 412, 414, 419 
Forest 2: Non-Deciduous / 421, 422, 423, 424 
Forest 3: Mixed / 430 
Forest 4: Wetland / 610 
Open 1: Water / 500, 620 
Open 2: Meadow / NA 
Open 3: Excavation / 710 
Other 1: Logging / 790 
Other 2: Unpaved Road / NA 
Other 3: Bedrock / 720 

 
Apply symbology to LLRM categories 

 
ArcCatalog > Copy “nhlc01_gregg_before” > Rename “nhlc01_gregg_after” 
 Import symbology to match “nhlc01_gregg_before” shapefile 

Set display transparency to 70% 
 
Data Management Tools > Feature Class > Create Fishnet 

Created 10x10 grid 
Deleted grids not covering watershed area 
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Labeled quads #0-99 
 
ADD PAVED & UNPAVED ROADS 

Downloaded “NH DOT Roads” from GRANIT and clipped to watershed area > “gregg_roads” 
Geoprocessing > Buffer > Input "gregg_roads"; buffer = 25 ft -> "gregg_roads_buff25ft.shp" 
Geoprocessing > Union > Input "nhlc01_gregg_after" and "gregg_roads_buf25ft" -> "nhlc01_gregg_after_rds" 

Unchecked “Gaps Allowed” 
Relabeled all former “Urban 3: Roads” to default “Forest 3: Mixed” 
Relabeled added road polygons as "Urban 3: Roads” under "LLRM_code" for paved roads [SURF_TYPE] OR as 

"Other 2: Unpaved Roads” under "LLRM_code" for unpaved roads [SURF_TYPE] 
 

ADD WETLANDS 
Download NWI Wetlands (https://www.fws.gov/wetlands/data/mapper.html) 
Clip to watershed -> “nwi_clip” 
Add text field > “LLRM” 

Lake (L1UBH) → Open 1: Water 
Freshwater Pond (PUB) → Open 1: Water 
Freshwater Forested/Shrub Wetland (PFO/PSS) → Forest 4: Wetland 
Upland (U) → Removed 
PEM → Forest 4: Wetland 

Geoprocessing > Union > Input " nhlc01_gregg_after_rds " and "nwi_clip" -> "nhlc01_gregg_after_rds_nwi" 
 Unchecked “Gaps Allowed” 

Relabeled all former “Open 1: Water” to default “Forest 3: Mixed Forest” 
Relabeled added nwi polygons as "Open 1: Water” under "LLRM_code" for open water [LLRM] OR as "Forest 4: 

Wetland” under "LLRM_code" for wetlands [LLRM] 
 
ADD STREAMS 

Download National Hydrography Dataset from NH GRANIT 
Clip to watershed -> “NHDFlowlines_GL” 
Geoprocessing > Buffer > Input "NHDFlowlines_GL"; buffer = 15 ft -> "gregg_streams_buff15ft.shp" 
Geoprocessing > Union > Input " nhlc01_gregg_after_rds_nwi " and "NHDFlowlines_GL" -> 

"nhlc01_gregg_after_rds_nwi_flow" 
 Unchecked “Gaps Allowed” 

Relabeled added stream polygons as "Open 1: Water” under "LLRM_code" for streams  
 
MULTIPART TO SINGLEPART 

Data Management Tools > Features > Multipart to Singlepart 
Input: “nhlc01_gregg_after_rds_nwi_flow” 
Output: “nhlc01_gregg_after_rds_nwi_flow_single” 

ArcCatalog > Copy "nhlc01_gregg_after_rds_nwi_flow_single" > Rename "gregg_landcover_v1" 
 
LAND COVER ANALYSIS 
 Step 1: Zoom to Quad #X; compare “gregg_landcover_v1” to most recent aerials 
 Step 2: If changes needed, used Topology tool to edit vertices or Editor tool to split polygons; relabel polygons in 

attribute table to appropriate LLRM land cover category 
 
ASSUMPTIONS 

Alterations to add in forested land cover was defaulted to “Forest 3: Mixed” 
Agricultural fields that were clearly not pasture or row crops were defaulted to “Agric 4: Hayfield”; it was difficult to 

discern whether a field was hayfield or cover crop and so no cover crops were delineated in the watershed 
Commercial lawns, and athletic/ camp fields were labeled as “Urban 5: Open Space/Mowed Fields”; residential lawns 

are included in Urban 1 
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Shrubby areas that may or may not have been the result of a logging operation (and regenerating) were labeled as 
“Open 2: Meadow” 

Major bare soil areas that were not associated with new residential home construction were labeled as “Open 3: 
Excavation” 

 
FINAL FILES 

"GreggLake_wshed.shp" = final watershed boundary 
"Gregg_subbas.shp" = final sub-basin boundaries 
"Gregg_LandCover_final.shp" = final land cover 

 
 
ATTACHMENT 2: Examples of Distinguishing Land Cover in Aerials 
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ATTACHMENT 3: Final Land Cover Map 
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ATTACHMENT 4: Land Cover by Sub-Basin 

Land cover phosphorus (P) export coefficients and land cover areas for sub-basins in the Gregg Lake watershed. Summed areas of sub-basins equal total 
watershed area minus the surface area of Gregg Lake. 
 

Land Cover 
Runoff P export 
coefficient used 

Baseflow P export 
coefficient used 

Area (hectares) 
Castor 
Lane 

Direct 
Shoreline 

Hattie Brown 
Road 

Hattie Brown Road 
North Trib 

Hattie Brown Road 
West Trib 

Willard 
Mountain 

Urban 1 (Low Density Residential) 0.79 0.010 0.9 14.6 0.0 0.0 0.0 1.0 
Urban 2 (Mid Density Residential/Commercial) 0.90 0.010 0.0 3.0 0.0 0.0 0.0 0.0 
Urban 3 (Roads) 0.30 0.010 0.0 3.0 0.0 0.0 0.0 0.0 
Urban 5 (Mowed Fields) 0.60 0.010 0.0 0.4 0.0 0.0 0.0 0.0 
Agric 3 (Grazing) 1.50 0.010 0.0 3.2 0.0 0.0 0.0 0.0 
Agric 4 (Hayfield) 0.37 0.010 0.0 1.3 0.0 0.0 0.0 0.3 
Forest 1 (Deciduous) 0.03 0.004 85.8 102.5 1.7 77.3 93.3 109.4 
Forest 2 (NonDeciduous) 0.03 0.004 17.1 32.5 17.7 3.1 6.0 16.8 
Forest 3 (Mixed) 0.03 0.004 69.0 122.7 34.5 22.8 11.4 70.9 
Forest 4 (Wetland) 0.03 0.004 16.6 7.2 6.2 1.0 0.6 12.6 
Open 1 (Water) 0.01 0.004 11.4 4.4 3.7 4.6 5.7 7.3 
Open 2 (Meadow) 0.20 0.004 3.1 25.8 0.0 0.4 1.0 5.2 
Open 3 (Excavation) 0.80 0.010 0.0 0.5 0.0 0.0 0.0 0.0 
Other 2 (Unpaved Road) 0.83 0.010 1.8 15.6 0.8 0.0 0.1 2.5 

TOTAL 205.7 336.6 64.5 109.2 118.1 226.0 
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ATTACHMENT 5: Estimating Pre-Development Phosphorus Load 

1. Converted all human land cover to mixed forest (Forest 3) and updated model.  
2. Removed all septic inputs (set population to zero).  
3. Removed internal loading, assuming internal loading was the result of excess nutrient loading from human 

activities in the watershed. 
4. Reduced atmospheric loading coefficient to 0.07 kg/ha/yr. 
5. Roughly matched outflow TP to predicted in-lake TP. 
6. Kept all else the same, assuming waterfowl counts and precipitation input did not change (though they likely did).  

 

ATTACHMENT 6: Estimating Future Phosphorus Load at Full Build-Out 

1. Estimated number of new buildings at full buildout by sub-basin. CommunityViz software uses model inputs such 
as population growth rates, zoning, wetlands, conservation lands, and other constraints to construction, and 
generates a projected number of new buildings in the future. The new building count was generated for each sub-
basin at full buildout. 

2. Calculated developed land coverage after full buildout projection. Each new building was assumed to generate 
new developed land uses, including buildings, roads, etc. Specifically, the calculated areas of Urban 1-5, Agric 3-4, 
Open 3, and Other 2 per new building (based on current land cover areas and number of existing buildings) were 
multiplied by the number of new buildings in each sub-basin. A total of 0.39 ha was converted per new building. 

3. Incorporated land use changes to LLRM for P loading predictions. Added the new developed land use figures to the 
LLRM. Within each sub-basin, existing un-developed land uses were replaced with areas equal to added developed 
land. 

4. Incorporated septic system loading to LLRM for P loading predictions. The number of new buildings within 250 feet 
of water was estimated from the CommunityViz output shapefile of projected new buildings. All other assumptions 
were kept the same. 

5. Increased atmospheric loading coefficient to 0.25 kg/ha/yr. 
6. Calculated potential increase in internal loading. We assumed a similar magnitude increase in future internal 

loading as compared to the increase in future total load to the lake. 
7. Roughly matched outflow TP to predicted in-lake TP. 
8. Kept all else the same. 
 

 
 


